
Procedures

Click an item for help on one of the following tasks: 

How to change dictionaries     

How to find the definition of a word.

How to find synonyms for the current word.

How to find a word using words in its definition.

How to find anagrams of a word.

How to use wild-card characters to find words that fit a pattern.

How to copy a word and paste it into a document.

How to copy a word from a document and paste it into a dictionary.

How to use Word of the Day 



Index

Click an item for help on one of the following topics: 

Change dictionaries     
Look up definitions
Look up synonyms (Thesaurus)
Look up definitions that use a given word (WordHunter)
Look up anagrams (Anagrams)
Look up words using wild-card characters
Look up spelling (Alternate Spellings)
Use Word of the Day 

Dictionary window buttons
Menu commands and shortcuts
Browse List
Results List
Navigating
Pronunciation guide



Look up definitions

To look up the definition of a word in either the American Heritage Dictionary or the Dictionary of Cultural 
Literacy, do one of the following:

1 First, choose the dictionary of choice from the References menu.

Then:

Type the word you want to look up

2 Type the word in the current word area.

As you type, the Browse list scrolls to the word in the dictionary that most closely matches the text 
you are entering.    If you see the word in the list, simply double-click on it to access that definition.

3 Press Enter or choose the Dictionary button.

Select a word you want to look up

2 Scroll through the Browse list, the Results list, or the Definition window to find the word you want.

3 Double-click on the word, or highlight it and choose the Dictionary button.

Select a word from a word processing document
2 In your word processing document, select the word you want to look up.

3 Choose American Heritage from a menu in your word processor.    The Dictionary automatically looks 
up the word you selected.    If you're using American Heritage Dictionary from the Control menu, copy 
your word to the Clipboard first.

See also

Install American Heritage Dictionary in your word processor
Look up a word displayed in another application
Word History
Definitions
Deluxe Dictionary



Browse list

When you first start a dictionary, the Browse list contains all the headwords in that dictionary.

Use any of the following methods to move through the Browse List:

Up and Down Arrows
Move one word at a time

Page Up and Page Down
Move one screen at a time

Home and End
Go to the top or bottom of the list

Scroll bar
Scroll through the list

Elevator
Scroll through the list while displaying letters that show your location in the active dictionary.

Type one or more letters
Move to the first word that starts with those letters

Click on a word
Move to that word

See also

Browse button
Look up definitions
Navigating
Results list
Word History



Install the American Heritage Dictionary in your word processor

Once you install American Heritage Dictionary and set it up to run with your Windows word processor, you
can use the Dictionary of Cultural Literacy and the American Heritage Dictionary to look up words in your 
document.

1 In the Program Manager, open the American Heritage Dictionary program group.

2 Choose the icon for the word processor you use:

Install to WordStar for Windows
Install to Microsoft Word
Install to Lotus AmiPro
Install to WordPerfect

3 A document opens in the word processor you chose.    Follow the instructions in the document to 
install American Heritage Dictionary in your word processor.

4 Once you install American Heritage Dictionary, it appears on the following menus:

WordStar for Windows Tools
Word for Windows 1.x Utilities menu
Word for Windows 2.x Tools menu
Word for Windows 6.0 Tools menu
WordPerfect for Windows Macros menu
Ami Professional Tools menu

You can install American Heritage Dictionary in more than one word processor.    Repeat the steps above 
for each application you want to use.

The active dictionary should start automatically when you run Windows.    If it doesn't, add AHD3.EXE to 
your startup group.

See also

Look up a word in a word processing document



Look up a word in a word processing document

Once you set up American Heritage Dictionary to run with your Windows word processor, you can look up
words in your documents, in either the Dictionary of Cultural Literacy or the American Heritage Dictionary.

1 While working in your word processing document, select the word you want to look up in the active 
dictionary.    (Double-click on the word.)

2 Choose American Heritage from a menu:

WordStar for Windows Tools menu
Word for Windows Tools menu or Utilities menu
WordPerfect for Windows Macros menu
Ami Professional Tools menu
All others Control menu

3 American Heritage Dictionary automatically looks up the definition of the word you selected.

See also

Install American Heritage Dictionary in your word processor
Look up a word displayed in another application
Copy words from a dictionary into your document



Look up a word displayed in another application

To look up a word in a Windows word processing document, see Look up a word in a word processing 
document.

To look up a word in another Windows application, make sure American Heritage Dictionary is running, 
then follow the steps below:

1 In the Windows application, select the word you want to look up.

2 Copy the word to the Clipboard.    (Press Ctrl+C or Ctrl+Ins in most applications.)

3 From the Control menu, choose The American Heritage Dictionary.

4 The American Heritage Dictionary automatically looks up the word on the Clipboard in the active 
dictionary.

See also

Copy words into your document
Install American Heritage Dictionary in your word processor



Results list

When you search for words using WordHunter, wild-card characters, Anagrams, or Alternate Spellings, 
the results of the search appear in the Results list.

Use any of the following to move through the Results List:

Up and Down Arrows Move one word at a time

Page Up and Page Down Move one screen at a time

Home and End Go to the top or bottom of the list

Scroll bar Scroll through the list

Type one or more letters Move to the first word that starts with those letters

Click on a word Move to that word

You can copy the contents of a Results list to the Windows Clipboard by using the Copy Results List 
command on the Edit menu, or highlight your selection and click on the Copy button.

See also

Browse list
Look up definitions
Navigating
Results button
Word History



Word history
To see a list of the words you looked up during your current session, select the arrow to the right of the 
current word area.

Select a word from the list to look it up.

Note:    The Up and Down Arrow keys also allow you to scroll through the list of words you've looked up 
during the current session.



Definitions

The definitions of the words you look up may include the following information:

Headword
The word you're looking up, showing correct spelling and hyphenation.

Pronunciation
A guide to pronunciation.    Accents show which syllable to emphasize.

Variants
Variant spellings of the headword.    For example, defense is also spelled defence in the British spelling.

Part of speech and inflections
The word's grammatical label:

abbr. abbreviation
adj. adjective
adv. adverb
aux. v. auxiliary verb
conj. conjunction
def.art. definite article
indef.art. indefinite article
interj. interjection
intr. v. intransitive verb
n. noun
pl. n. plural noun
pref. prefix
prep. preposition
pron. pronoun
suff. suffix
tr. v. transitive verb
v. verb

Definition
The meanings of the word.

Label
A word's label indicates if it is related to a particular subject area, level of usage, or geographic area.    For
example, white-knuckle is considered slang.

The Deluxe edition of The Dictionary lists the following information.

Cross-reference
If information about this word appears in the listing for another word, the definitions are cross-referenced, 
as in featheredge, see deckle edge.

Order of senses
Multiple meanings or senses appear in the order of their popularity.    For example, fatal has two senses:    
Fatal: 1. Causing or capable of causing death.    2. Causing ruin or destruction; disastrous.

Attributive
If a noun is used to modify other nouns, it is listed as an attributive, as in gas: attributive - gas tanks, gas 
stoves.

Phrasal verb



A phrasal verb is an expression consisting of a verb and an adverb or a preposition, such as set: set 
about.

Idiom
An idiom is an expression of two or more words, such as take: on the take.

Etymology
The origin and historical development of a word.    The derivation is listed from most recent to the earliest 
known form of the word.    A language name, linguistic form, and brief definition or gloss appear for each 
form.    Etymologies may also include the following:

Italics Italic type is used for non-Modern English linguistic forms.

Small capitals Small capitals are used for cross-references to other etymologies in The 
Dictionary.

Synonyms
Words with meanings that are similar or related to the meaning of the headword.    For more synonyms, 
see Look up synonyms (Thesaurus).

Usage notes
For words where usage is in dispute, the opinion of a panel of linguistic experts appears.

Regional notes
For words used only in certain areas of the United States, regional notes appear, as for dragonfly.

Indo-European roots
Entries for words that have Indo-European roots may include the following characters:

* An * (asterisk) means that the form of the word is unattested or unconfirmed, but thought to be 
reasonably accurate.

< A < (less than symbol) indicates that the word is derived from another form of the word.

> A > (greater than symbol) indicates that the word developed into another form of the word.

See also

Deluxe Dictionary
Pronunciation guide



The Talking and Deluxe Dictionaries

If you have the Deluxe or Talking editions of the American Heritage Dictionary, you can find information on
the following types of entries.

Abbreviations
Both dictionaries provide definitions for abbreviations.    Type an abbreviation, such as cpu, as the current
word to find its definition.

Biographical entries
These dictionaries list biographical information, including the person's vocation, date of birth, and date of 
death.    Type the person's name as the current word.

Geographical entries
Both dictionaries list geographic information, including the name of the place, pronunciation of the name, 
and explanation of its location.    Type the name of the location as the current word.

Universities and colleges 
These dictionaries provide information about America's two- and four-year colleges and universities, 
including enrollment and location.    Type the name of the college or university as the current word.

Indo-European roots 
Both dictionaries include information about Indo-European roots.    Type a root, such as gwei-, as the 
current word, or select it from the Results or Browse list to see its definition.



Results button

Select the Results button to see the list of words generated by your last search with WordHunter, 
Anagrams, Alternate Spellings, or wild-card characters.    If a Results list is already visible, select the 
Results button to cycle through the other lists.

Select a word (double-click on it) to look it up.

See also

Browse button
Dictionary window buttons
Results list
Word History



Browse button

Select the Browse button to see the entire list of headwords in the Dictionary of Cultural Literacy or the 
American Heritage Dictionary.

Select a word (double-click on it) to look it up.

See also

Results button
Dictionary window buttons
Browse list
Word History



Copy words into your document

To copy a word or phrase from a dictionary into your Windows document:

1 Make sure both American Heritage Dictionary and your word processor are running.    (Start your word
processor, then choose American Heritage Dictionary from a menu.)

2 Look up a word in a dictionary.

3 Highlight the text you want to copy from the dictionary.

4 From the Edit menu, choose Copy or click on the Copy button.

5 Return to your document.    Move the cursor to the place where you want the text to appear.

6 From your word processor's Edit menu, choose Paste.

See also

Install American Heritage Dictionary in your word processor
Look up a word in a word processing document



Look up synonyms/antonyms (Thesaurus)

To look up synonyms or antonyms for a word, do one of the following:

Type the word you want to look up

1 Type the word in the current word area.

2 Select the Thesaurus button to see synonyms and antonyms only, or select the Split button to see 
synonyms, antonyms and definitions.

 Select a word you want to look up

1 Scroll through the Browse list, Results list, or the Definition window to find the word you want.

2 Select the word, and then select the Thesaurus button.

Select a word from a word processing document

1 In your word processing document, select the word you want to look up.

2 Choose American Heritage from a menu in your word processor.

3 Select the Thesaurus button to see only synonyms and antonyms, or select the Split button to see 
synonyms, antonyms and definition.

See also

Install American Heritage Dictionary in your word processor
Look up a word in a word processing document
Look up a word displayed in another application
Word History
Synonym window



Synonym/Antonym window

The Thesaurus looks up synonyms, or words that have similar meaning and antonyms, or words that 
have the opposite meaning.

The list shows synonyms and antonyms for each definition of the word you looked up.    Use the scroll bar 
to see all the entries.

To look up synonyms and antonyms for a word in the Thesaurus window, double-click on the word.

Seeing definitions, synonyms and antonyms
You can open a separate window for synonyms and antonyms so you can view a word's definitions and 
its synonyms and antonyms at the same time.    Select the Split button.

See also

Look up definitions



Look up definitions that use a given word (WordHunter)

WordHunter looks for definitions that contain a given word.

1 Select the WordHunter button.

2 Type a word you expect to find in a definition, and click OK.    You can also use logical expressions 
and labels to refine your search.    

To find definitions even if the word you enter is part of a longer word, select the Partial Words check 
box.    Although this slows down the search, you could type round and get definitions containing 
round as part of a word, such as around, surround, or rounded.

To search for words whether they're capitalized or not, select Ignore Capitalization.

3 WordHunter displays the words it find in the Results List.

See also

Restrict search using labels
Restrict search using logical expressions



Restrict search using labels

WordHunter lets you select a word label to search for words that have a particular usage in certain 
subjects.    For example, you can restrict the search to accounting terms or words in British usage.

1 Select the WordHunter button.

2 Type the word you want to search for in the current word area.

3 From the Labels list, select the label you want.    For example, select Accounting.

4 Press Enter.

See also

Restrict search using logical expressions



Restrict search using logical expressions

With WordHunter, you can use logical expressions to broaden or narrow your search.

Use the following buttons to create logical expressions.    You can also type AND, OR, NOT and 
parentheses if you like.

AND Use a AND b to search for words containing both a and b in their definitions.

OR Use a OR b to search for words containing either a or b in their definitions.

NOT Use a NOT b to search for words containing a but not b in their definitions.

Parentheses Use parentheses to refine your search.    For example, type (a OR b) AND c to 
find words that contain either a or b, and also contain c in their definitions.

You can halt a search by pressing the Escape key.    A partial list of the results (those words located at the 
time the search was halted) appears in the Results list.



Look up anagrams (Anagrams)

Use Anagrams to find words containing the same letters as the current word.

1 Select the Anagrams button.

2 Type a word, and then press Enter.

3 The Results List contains anagrams for the word you entered.

You also have the following options when looking for anagrams:

Select Full Word to search for anagrams containing all the letters in the current word.

Type the minimum number of letters you want to use if you want to eliminate shorter words.    For 
example, type 4 as the minimum number to find words of four letters or more.



Look up words using wild-card characters

You can use wild-card characters to find words that fit a pattern or when you know only some letters in a 
word, such as when you're solving a crossword puzzle.

1 Type a combination of letters and wild-card characters in the current word area.

Use ? (question mark) to stand for a single character.    For example, type h??t to find four-letter 
words that begin with h and end with t, such as heat and hurt.

Use * (asterisk) to stand for an indefinite number of characters.    For example, type h*t to find any
word that begins with h and ends with t, such as hit, heart, and handcart.

2 Press Enter to see a Results List containing all the words that match the pattern you typed.



Look up spelling (Alternate Spellings)

Use the Alternate Spellings option to check alternate spellings for a word, or to check the spelling of 
words that are often confused.

1 Type a word in the current word area.    For example, type council to check its alternate spellings.

2 From the Options menu, select Alternate Spellings.

3 The American Heritage suggests alternate spellings in the Results List.    For example, the dictionary 
suggests consul and counsel as alternate spellings for council.



American Heritage Dictionary window buttons

Select a button to work with different parts of the American Heritage Dictionary:

Dictionary Look up the definition of the current word in the active dictionary.

Thesaurus Find synonyms for the current word.

Split Show a word's definitions and synonyms at the same time.

Previous Go to the previous word in the dictionary.

Next Go to the next word in the dictionary.

Copy Copies the selection to the clipboard.

WordHunter Search for a word by typing one or more words you expect to find in its definition.

Anagrams Find words you can make from the letters in the current word.

Results See the results of your last search.

Browse See a list of all the words in the selected dictionary.

Pronounce If you are using the Talking version of American Heritage Dictionary, clicking on 
this button pronounces the current word.

See also
Menu commands and shortcuts
Navigating



Menu commands and shortcuts

Select one of the following menus:

File
Edit
References
Options



File menu

Command Shortcut/Accelerator Description
____________________________________________________________________________

Exit Alt+F, then X Exits The Dictionary.



Edit menu

Command Shortcut/Accelerator Description
____________________________________________________________________________

Copy Ctrl+C Copies the current word or selected text to the 
Clipboard.

Copy Results List Ctrl+L Copies the Results list to the Clipboard.

Paste Ctrl+V Pastes the contents of the Clipboard into the current 
word area.

Note:    When you paste the contents of the Clipboard into the American Heritage Dictionary, only the first 
43 characters are placed in the current word area.

See also

Copy words from a dictionary into your document



Options menu

Command Shortcut Description
____________________________________________________________________________

Alternate Spellings Ctrl+A Check for alternate spellings of a word.

Dictionary Ctrl+D Open a dictionary.

Thesaurus Ctrl+T Open the Thesaurus.

Split Screen Ctrl+S Displays both the active dictionary and the thesaurus 
entry for the active word.

Change Results List Choose one of these to change the Results list:

Alternates:    See the list of words from the last time The
Dictionary found alternate spellings.

Anagrams:    See the list of words found the last time 
you used Anagrams.

Synonyms/Antonyms:    See the synonyms/antonyms 
found the last time you highlighted a synonym/antonym 
in the Thesaurus window, then select the Dictionary 
button.

Wild Card:    See the list of words found the last time you
entered wild-card characters.

WordHunter:    See the list of words found the last time 
you used WordHunter.

Always on Top Keep the American Heritage Dictionary icon on the top 
level display.

Appear on System Menus Include the American Heritage Dictionary as an option 
on your system menus for any Windows applications.

Auto Lookup Automatically look up words on Clipboard when 
restoring American Heritage Dictionary from a minimized
state.

Change Font Size Change the size of the font in the Definition window.

Auto Pronounce If you are using the Talking version of the Dictionary, 
select on of the Pronounce options:    Off, On - 1, On - 2, 
or On - 3.    When Off is checked, the word will not be 
pronounced, the other options pronounce the word once,
twice, or three times.

Word of the Day Accesses the Word of the Day dialog box. Select the 
desired word list (Intermediate, Advanced, or Expert), 
whether a Word of the Day is displayed at startup, and 
choose to view the next word.



References Menu

Command Description
____________________________________________________________________________

American Heritage Dictionary Accesses the American Heritage Dictionary

Dictionary of Cultural Literacy Accesses the Dictionary of Cultural Literacy

The References menu allows you to choose a dictionary from which you'll look up words and/or phrases.   
The American Heritage Dictionary can be used to lookup definitions of words such as "haberdasher" and 
"ubiquitous;" while the Dictionary of Cultural Literacy can be used to lookup concepts, such as the 
greenhouse effect, or historical figures, such as George Washington.



Navigating

To select a menu from the menu bar:

Use the mouse to click on the name of the menu.

Press Alt and the underlined letter of the word on the menu.    For example, type Alt+F to select the 
File menu.

To select a button:

Use the mouse to click on the button.

Press Alt and the underlined letter of the word on the button.    For example, type Alt+T to select the 
Thesaurus button.

To highlight a word in a definition or list:

Click on the word with your mouse.

Use the Arrow keys or the scroll bar to move the highlight bar to the word.

Type the first few letters of the word in a word list.

To select a word in a definition or list:
Double-click on the word with your mouse.

Press Enter when the word is highlighted.

See also
Menu commands and shortcuts
Browse list



Pronunciation guide
Symbol Sample Words

² pat
³ pay
âr care
ä father
b bib
ch church
d deed, milled
µ pet
¶ bee
f fife, phase, rough
g gag
h hat
hw which
¹ pit
º pie, by
îr pier
j judge
k kick, cat, pique
l lid, needle
m mum
n no, sudden
ng thing
¼ pot, horrid
½ toe, hoarse
ô caught, paw, for
oi noise
‹ took
› boot
ou out
p pop
r roar
s sauce
sh ship, dish
t tight, stopped
th thin
th this
¾ cut
ûr urge, term, firm, word, heard
v valve
w with
y yes
z zebra, xylem
zh vision, pleasure, garage
… about, item, edible, gallop, circus



…r butter



Changing dictionaries

Select the desired dictionary (American Heritage Dictionary or the Dictionary of Cultural Literacy) from the
References menu.    Your selection remains active until you choose the other dictionary.



Using Word of the Day

It's easy to improve your vocabulary with Word of the Day. If you choose to select this option, each time 
you open The Dictionary, you'll see a new word and its definition.    You can choose to see words from one
of three levels of difficulties:    intermediate, advanced, and expert.

To use Word of the Day:

1        Start The American Heritage Dictionary.

2        Choose Word of the Day from the Options menu.

A new word and its definitions appear.

3        Toggle the Show Word of the Day at Startup option on or off.

If the box is checked, a new Word of the Day appears each time you start the program. Click the box 
again to clear it if you don't want to see Word of the Day when you start the program.

4        Select a difficulty level for the words from the drop-down list.

            You can choose from Intermediate, Advanced or Expert.

5        If you like, click on Next Word to see another word from the active level.

6        When you are done viewing words, click on OK.

If you chose to see the Word of the Day at startup, when you start The American Heritage Dictionary, 
you'll see the Word of the Day and its definition, along with all of the options described above.




